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Overview

« This application intends to provide an overview the usage to Alpha Date Picker.
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Creating a New Web Site

Step 1: How to add a new website in Microsoft Visual Web Developer 2010 Express.

1) Click File->New Web Site menu item. The New Web Site dialog box appears,as shown bellow

MNew Web Site

Search Installed Templates

Recent Templates Sort by: [Default

Installed Templates . —
- : 3 ASP.NET Web Site Visual C# ype: Visua
Visual Basic L=t G saaiil

Visual C#
% ASP.NET Empty Web Site Visual C#

Online Templates

f?/ ASP.MET Dynamic Data Entities Web Site Visual C#

E%,’ ASP.NET Dynamic Data Ling to 5SQL Web Site Visual C#

:cg‘ili WCF Service Visual C#

Web location: File System * | EAWork\WebSitel b Browse...

2) Selectan ASP.NET Empty Web Site option
3) Click on the Browse button and select or enter the location where you want to save the website.
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4) Right click on the website in the solution explorer and add the Bin folder from the menu item Add
ASP.NET Folder as shown in the diagram.

[£] WebsSite1 - Microsoft Visual Wel Ad
File Edit View Website Debug Help.
iG-S @ 4 B9 - - b [Debug -1 | # [ clearBoth B
i (@) Install Web Components _

indoy

Solution Explorer
SaE ok

S \WebSited|
onfig

sapdoig B

% Build Web Site
1 Add Newkem.. Ctrl+Shift A
J Add Existing Item... ShifteAlts A
New Folder
Bin Add ASP.NET Folder
App_Code Add Reference...
App._GlobalResources Add Service Reference...
App_LocalResources Add Deployable Dependencies..
App_ WebReferences Copy Web Site.
App_Data Start Options.
Sl € Viewin Browser Ctrl+Shift+W
hinie Browse With...
Refresh Folder
¢ Cut CuleX
) Copy CtrleC
, Paste Carlsy
Properties Window F
Property Pages Shift+FA

EE Database Ex..

B Output

L A N
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5) After adding Bin folder under “Add ASP.NET Folder” in your website again do right click on the website

and click on the Add New Item option.

[5] websitel (2) - Microsoft Visual Web Developer 2010 Lo

File Edit View Website Debug Tools Window Help

P S @ % B9 - | b (8 [Debug

v| | (% |statu;

'||EE:

Toolbox

4 General

B ErorList B Output

Add ASP.NET Folder

Add Reference...
Add Web Reference...

Add Service Reference...

Copy Web Site...
Start Options...
View in Browser
Browse With...
j Refresh Folder

Paste

Properties Window
Property Pages

Solution Explorer

Ela ok

T : ebSitel\|
There are no usable [£4  Build Web Site Data
controls in this group. Drag . o
e L 3 Add MNew Itern... Ctrl+Shift+4 config
add it to the toolbox, [ Add Existing Item... Shift+Alt+A
4 Mew Folder

Ctrl+Shift+W

Ctrl+ X
Ctrl+C
Ctrl+V
F4
Shift+F4
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6) After click on the Add New Item option, system will open a new window. Now, you can select a Web
Form from the option and click on add button. Now, you can see Default.aspx page is added in your

website.
Add New Ttem - E\Work\WebSite1! [ =
Installed Templates Sort by: [Default | Search Installed Templates P |
Visual Basic . ;
e —_ | Type: Visual C#
Visual C2 S7=| WebForm Visual C# WP e
EE= -
Aform for Web Applications
Online Te e
Inline;[Empltss Master Page Visual C#
Web User Control Visual C#
Qg ADO.MET Entity Data Model Visual C#
Qg ADO.MET EntityObject Generator Visual C#
Q'g ADO.MET Self-Tracking Entity Generator Visual C#
‘Cg‘ili AlAK-enabled WCF Service Visual C&
1'3 | Browser File Visual C#
ch] Class Visual C#
‘j:ilj’.] DataSet Visual C#
I=] e e - i
MName: Default.aspx Place code in separate file
|| Select master page
e
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Step 2: How to add Alpha Date Picker control in your website

- Add the AlphaDatePicker dll file in the Bin folder of your site. Just copy the AlphaDatePicker.dll and

AlphaDatePicker.xml files and paste under the Bin folder of your website.
Solution Explorer * 0

=P E\Work\WebSitel\,
a4 |7 Bin
|%| AlphaDatePicker.dll
=] AlphaDatePicker XML
(=| Default.aspx
i Web.config

» For using AlphaDatePicker web server control it should be added to the project. For the ease of use we
will explain,how to add the AlphaDatePicker to your project.

o Open the toolbox and right click on it and choose Add Tab.
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[~ e —— a3
El WebSitel - Microsoft Visual Web Developer 2010 Express (Administrater) E@ﬂ
- ————— - — - T W Wy e
File Edit View Wehsite Debug Format Toels Window Help
Pl S @ % SB[ - | b [Debug  -|| (B [retums datetime )| -
i | (Mew Inline Style) b J_,| (Mone) (Default Font) (Default -| | B 7 U | A & | = - | == | 2 | - |
o
Toolbox v 0 Xl Defaultaspx* ~ Solution Explarer * @ x
> Standard Lbody| = |2k zE =8
.r. >Dat.a . 2P EAWork\WebSitel\ o
| >‘u‘a||t.:|at|?n 4 [ Bin
> Navigation %] AlphaDatePicker.dll
> Lagin =] AlphaDatePicker.XML
> WebParts s ,EDefauIt.aspx
> AJAX Extensions 3 Web.config
> Dynamic Data
> HTML
» General
Paste Ctrl+Vf
List View
Show All

Choose Items...

Sort ltemns Alphabetically
Reset Toolbox

Add Tab

Delete Tab

EI oo, -:? i) =l B Database Ex...

Rename Tab

B Output Mowve Up

Ready Move Down

o Choose a name for it. Here we put AlphaDatePicker
o Right Click on the AlphaDatePicker tab and select, ‘Choose items...” as shown in diagram :
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[ S — 1
El WebsSitel - Microsoft Visual Web Developer 2010 Express (Administrator) E@g
- - - — e M e e o oy
File Edit View Website Debug Format Tools Window Help
Eﬂ‘_]‘jﬂﬂ| b S| 9-™ '| b ﬂ|Debug '||m|retumsdatetime '||EH:
(New Inline Style) at? _IJ| (None) (Default Font) (Default | B G (R el = '| SE | | F ;
o
Toolbox v 1 X || Default.aspx* X ~ Solution Explorer L
> Standard :Ibodyl 7 [\"_§1| E éﬁ | Bl= @ ’g
| R P E\Work\WebSite1\
| >Va||c.lat|?n 4 B Bin
g Hlaigation &) AlphaDatePicker.d
> Login 2] AlphaDatePicker XML
> WebParts > [Z] Default.aspx
> AJAY Extensions % Web.config
> Dynamic Data
> HTML
4 AlphaDatePicker
| [ Paste Ctrl+V
Therearenousal ' List View
controls in this groug
an item onto this te Show All
add it to the toolk Ghoneeil el
Sort ltems Alphabetically
> General )
Reset Toolbox
Add Tab s
Delete Tab !
Rename Tab E| e |E| L'-"fg A9 B Database Ex...
B Output Maove Up
Move Down
- -

After click on the “Choose Items...” a window will be open named as “Choose Toolbox Items”.
Click on the tab “.NET Framework Components”. Click the browse button and select
AlphaDatePicker.dll file from the Bin folder of your website.

Choose Toolbox Items

(2

NET Framework Components | COM Components | WPF Components | Silverlight Components|

MName Mamespace Assembly Name Directory o
[] DataGrid System.Web ULWebControls Systern.Web Global Asse...
DataGridView System.Windows.Forms System.Windows.For...  Global Asse... I
[C] DataGridViewCombo... System.Windows.Forms System.Windows.For...  Global Asse... |
[[] DataGridViewTextBo... System.Windows.Forms System.Windows.For...  Global Asse...
Datalist System.Web ULWebControls Systern.Web Global Asse...
DataPager System.Web.ULWebContraols Systermn.Web.Extensions  Global Asse..
[[] DataRepeater Microsoft.VisualBasic.Power...  Microsoft.VisualBasic... Global Asse...
DataSet System.Data Systern.Data Global Asse...
[C] DataView System.Data Systermn.Data Global Asse...
[C] DataViewManager System.Data Systemn.Data Global Asse...
DatePicker AlphaControls AlphaDatePicker (1.0.... EAWork\W... 1
Fal . v ne ~ aae r ~ A - Pl B Y
Eilter:
DatePicker
= Language: Invariant Language (Invariant Country)

l

OK

)

Cancel

I

Reset ]

o Now you should have a DatePicker tool in the AlphaDatePicker tab.
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/_‘.:a Toolbox X
=N © Standard
% > Data
el Validation
> Navigation
> Login
> WebParts
> AJAX Extensions
> Dynamic Data
> HTML
4 AlphaDatePicker
k  Pointer

E7  DatePicker

DatePicker

Version1.0.0.21 from Alpha Net Technologies Pvt.
Ltd., Chandigarh, India

NET Component

o Now select the DatePicker control under the AlphaDatePicker tab and drag on to your web page.
Now, you will see the DatePicker control on to your Default.aspx page.

F —
@ WebSitel - Microsaft Visual Web Developer 2010 Express (Administrator)

File Edit Wiew Website Debug Format Tools Window Help

iﬂ'_]‘[jlﬂﬂ|f, -_'_:1[3|‘—'1 R ji|Debug v|||2§|retumsdatetime '||Eli|]1:
i | (New Inline Style) a2 4y | [(None) (Defautt Font) Defaut -|| B 2 U | A Z|E-|EE|R| B2

Toolbox BEEN X EeE Bin/AlphaDatePicker. XML v

I» Standard E|§é§|EE|EB

1> Data =P E\Work\WebSitel\
[ Validation ’ .

sapadoig

4 |5 Bin

1> Navigation

[ Legin

> WebParts

[» AJAX Extensions

I Dynamic Data

» HTML

4 AlphaDatePicker
k  Pointer
Fq  DatePicker

I General

B Output

Ready

4

O Split | B Source |

| AlphaDatePicker.dll
=] AlphaDatePicker XML
S| Default.aspx
5 Web.config

L“?a Solution Ex... E Database Ex...
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Step 3: How to use properties of Alpha Date Picker control

e Definition of Enum
1. public enum DateFormat

Summary: Date Formats:

ddMMyyyy,MMddyyyy,ddMMMyyyy, MMMddyyyy,ddMMMMyyyy, MMMMddyyyy
Items:

o ddMMyyyy for Date Format as “dd/mm/yyyy”

o MMddyyyy for Date Format as “mm/dd/yyyy”

o ddMMMyyyy for Date Format as “dd mmm yyyy”

o MMMddyyyy for Date Format as “mmm dd yyyy”

o ddMMMMyyyy for Date Format as “dd mmmm yyyy”

o  MMMMddyyyy for Date Format as “mmmm dd yyyy”

2. public enum InitialValueMode

L]

Summary: Intial Value Mode: Null or Today

Items:

o Null for Intial value mode as “Null”

o Today for Intial value mode as “Today”

Note: Here “Null” stands for “1/1/1753 12:00:00 AM”

3. public enum DisplayMode

L]

Summary: Display Mode: Label or Textbox
Items:

o TextBox for Display mode as “Textbox”
o Label for Display mode as “Label”

« Definition of Properties
1. public DateTime Date { get; }

Description: Returns DateTime representation of the currently selected date

Default Value=“1,1,1753" of type DateTime

Example

o Source Code
DatePickerl.InitialValueMode

AlphaControls.InitialValueMode.Today;
or
DatePickerl.InitialValueMode = AlphaControls.InitialValueMode.Null;
DateTime dtDate = (DateTime)DatePickerl.Date;
Response.Write(dtDate);
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[ @ nhitp://localhost:4917... [EEEE) [ & hitpi/flocalhost4917.., = E [ |
(I ] http/stocah... ~| & |45 (s |&] nttp/localh... ~| & |49
¢ Favorites | € http://localhost49172/. ¢ Favorites | € hitp:/flocalhost49172/.

£/30/2011 12:00:00 AM I 1/1/1753 12:00:00 AM !
30/08/2011
| @ Intenet [ Prote 3 v #100% -+ | @ Interet | Prote 45 v ®100% ~

e h

If we set the IntialValueMode property of the DatePicker If we set the IntialValueMode property of the DatePicker
control to Today then current system date will be control to Null then lowest date of the Sqgl Server (i.e.

displayed by the control '"1/1/1753") will be displayed by the control
example: example:
DatePickerl.InitialValueMode = DatePickerl.InitialValueMode =
AlphaControls.InitialValueMode.Today; AlphaControls.InitialValueMode.Null;

2. public DateFormat DateFormat { get; set; }

» Description: A System.DateTime format specifier to set the format of the selected date

» Default Value=DateFormat.ddMMyyyy

« Example

o Source Code

DatePickerl.InitialValueMode = AlphaControls.InitialValueMode.Today;
DatePickerl.DateFormat = AlphaControls.DateFormat.ddMMyyyy;
DateTime dtDate = (DateTime)DatePickerl.Date;
Response.Write(dtDate);

@ httpflocalhost4917... (L=l 5 med S|
o e |é. http://localh... v| B | 5

‘.T:? Favorites (& http://ocalhost:49172/..

-

8/30/2011 12:00:00 AM

30/08/2011 [EE

€D Internet | Prote #3 = #100% -

3. public string DateString { get; set; }
» Description: Gets or sets the shortdate string representation of the currently selected or entered
date
» Default Value=
« Example
o Source Code
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1. Note: If the InitialValueMode Enum is set to Null & DateFormat Enum sets to any given
format (here it is MMMMddyyyy) and DateString Format does not match the DateFormat

Enum's Format, then DatePicker Control displays DateString Value but Date property of
DatePicker object displays “1/1/1753'

DatePickerl.InitialValueMode = AlphaControls.InitialValueMode.Null;
DatePickerl.DateFormat = AlphaControls.DateFormat.MMMMddyyyy;
DatePickerl.DateString = "20 Jan 2011";

DateTime dtDate = (DateTime)DatePickerl.Date;
Response.Write(dtDate);

@ http/Nocalhost4917... (sl e

bl ) |§. http://localh... '| b | e

7.¢ Favorites & http://localhost:49172/..

1/1/1753 12:00:00 AM

20 Jan 2011 [EE

& Internet | Prote ¥ ~ #®100% -

2. Note: If the InitialValueMode Enum is set to Today & DateFormat Enum sets to any
given format (here it is MMMMddyyyy) and DateString Format does not match the
DateFormat Enum's Format, then DatePicker Control displays DateString Value but Date
property of DatePicker object displays the current system date.

DatePickerl.InitialValueMode = AlphaControls.InitialValueMode.Today;
DatePickerl.DateFormat = AlphaControls.DateFormat.MMMMddyyyy;
DatePickerl.DateString = "20 Jan 2011";

DateTime dtDate = (DateTime)DatePickerl.Date;
Response.Write(dtDate);

@ hitp//localnostA917.. Lol nED: e

bt () |E_;. http://localh... ‘| ﬁ | 3

.5 Favorites & http://localhost:49172/..

A

8/30/2011 12:00:00 AM

20 Jan 2011 [==-

€ Internet | Prote #3 ~ #100% = I
= = ———— —
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3. Note: If the InitialValueMode Enum is set to Today or Null & DateFormat Enum sets to
any given format (here it is MMMMddyyyy) and DateString Format match the
DateFormat Enum's Format, then DatePicker Control displays DateString Value & Date
property of DatePicker object displays the mentioned date in DateString property.

DatePickerl.InitialValueMode = AlphaControls.InitialValueMode.Today;
DatePickerl.DateFormat = AlphaControls.DateFormat.MMMMddyyyy;
DatePickerl.DateString = "January 20 2011";

DateTime dtDate = (DateTime)DatePickerl.Date;
Response.Write(dtDate);

@ htpi/localnostAgL7.., (e o) )
bl ) |g http://localh... v| I |¢f

i Favarites | (@ http://localhost49172/..

1/20/2011 12:00:00 AM

January 20 2011 [E]=

€ Internet | Prote ¥ ~ #100% -

(% = -

4. public DisplayMode DisplayMode { get; set; }
« Description: Gets or sets the display mode
« Default Value= TextBox
« Example
o Source Code
DatePickerl.DateString = "20/01/2011";
DatePickerl.DisplayMode = AlphaControls.DisplayMode.Label;

or
DatePickerl.DisplayMode = AlphaControls.DisplayMode.TextBox;
DateTime dtDate = (DateTime)DatePickerl.Date;
Response.Write(dtDate);
f @& httpy/focalhost:4917... = [ | (@ nttp/ocalnost4917... [ Bl [ |
'\-./,' l\:;,' |§, http://localh... - | =] | + '\;/l \;; |§, http://localh... v| = | 5
i Favorites | @ http://localhost:49172/.. ¢ Favorites | @ http://localhost49172/..
1/20/2011 12:00:00 AM 1/20/2011 12:00:00 AM
20/01/2011 == 20/01/2011 [
& Internet | Prote ¥4 ~ #100% - & Internet | Prote #3 v #100% ~
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Here we change and select the value because we can
change the value in the textbox.
DatePickerl.DisplayMode =
AlphaControls.DisplayMode.TextBox;

5. public string EndYear { get; set; }

Here we can only select the value due to the Label display
mode.

DatePickerl.DisplayMode =
AlphaControls.DisplayMode.Label;

« Description: Specifies the ending year for the calender, default value is current year
«  Default Value=Current Year in four digits like “2008”

« Example
o Source Code

DatePickerl.EndYear = "1991";

& alphalTworld Calendar... | = i:h]

|£ http://localhost:49172 /WebSitel / ":el:| = |

TODAY

August + 15991 (=

m

NON

Mo | Tu We Th

i
S|6|7|8
12113 |14 |15
19 (20|21 |22
26|27 (28|29

@ Internet | Protec

1962 .
1963
1564
1965
1966
1967
19638
1969
1970

1971
1972 [R100% ~

1973 "]

6. public string ImageUrl { get; set; }

1574
1975
1976
1977
1978
1979
1980
1981
1982
1983
1984
1985 |=
1986
1987
1988
1989
19590

- Description: Gets or sets the url to use the calender image button

« Default Value=
« Example
o Source Code

DatePickerl.ImageUrl = "~/CustomDatePicker.png";

Confidential alphalTworld Page 16 of 22



Alpha Net Technologies Pvt. Ltd. Alpha DatePicker Installation Guidelines

@ httpi//localhostA9,., il = e
et €] hitp://localh... | &

57 Favorites | @ hitp://localhost:4017]

30/08/2011 ]

@ Internet | P ¥3 v #100% ~

7. public InitialValueMode InitialvValueMode { get; set; }
- Description: Gets or sets the behaviors when the control initialize and a date has not been
selected
« Default Value= Today
« Example
o Source Code

DatePickerl.InitialValueMode = AlphaControls.InitialValueMode.Today;

or
DatePickerl.InitialValueMode = AlphaControls.InitialValueMode.Null;
DateTime dtDate = (DateTime)DatePickerl.Date;
Response.Write(dtDate);
[ @ netpuriocalnost:4917... (e B e | [ @ netpiocalhostas1y... (el B e
b i |§. http://lecalh... v| kA |¢f b i) |g http://localh... v| b | 4
7 Favorites | @& http://localhost:49172/.. i Favorites | @ http://localhost49172/..
8/30/2011 12:00:00 AM 1/1/1753 12:00:00 AM

30/08/2011 [EEl

€D Internet | Prote ¥3 ~ #100% - € Internet | Prote 43 ~ #100% ~

h h

If we set the IntialValueMode property of the DatePicker If we set the IntialValueMode property of the DatePicker
control to Today then current system date will be control to Null then lowest date of the Sqgl Server (i.e.

displayed by the control '"1/1/1753") will be displayed by the control
example: example:
DatePickerl.InitialValueMode = DatePickerl.InitialValueMode =
AlphaControls.InitialValueMode.Today; AlphaControls.InitialValueMode.Null;

8. public bool IsNull { get; }
« Description: Returns boolean about validity of date
» Default Value= false
« Example
o Source Code
1. When IntialValueMode is Null.
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DatePickerl.InitialValueMode = AlphaControls.InitialValueMode.Null;
Response.Write(DatePickerl.IsNull);

@ httpi//localhost49,. [ sl e
s & http://localh... « | &=

5l Favorites | @ http://localhost:49174

-

True

EE=

€ Internet | Pn ¥5 ~  #100% ~

2. When IntialValueMode is Today.
DatePickerl.InitialValueMode = AlphaControls.InitialValueMode.Today;
Response.Write(DatePickerl.IsNull);

@ http:/flocalhost:A9... ||l e S
vuv £ http://localh.. ~ | &=

i Favorites | @ http://localhost:4917]
False T
30/08/2011 [~ r

€D Internet | Pn #5 ~  #100% ~ -

9. public Style LabelStyle { get; set; }
« Description: Apply Label control style
«  Special Note: this is InnerProperty & we can apply Theme on it too.
» Default Value= NA
« Example
o Source Code
<alphalTworld:DatePicker ID="DatePickerl" runat="server"
DisplayMode="Label">
<LabelStyle BackColor="Black" ForeColor="White" />
</alphalTworld:DatePicker>

IE ™y
@ httpy/flocalnost:49... il S

K_J\_/ |& hitp://localho: v| @|
=3

sy Favorites | @ http://localhost4917]

[

€ Internet [P 5 v H100% -
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10. public bool NoneRequired { get; set; }
» Description: Returns boolean about visibility of 'None' button on the calender.
« Default Value= True
+ Example
o Source Code
1. When None link button is not required.
DatePickerl.NoneRequired = false;

r T ~
& alphalTworld Calendar...l. = i:hJ

[£] http://localhost:48172/WebSitel/ .'--eI:| B |

TODAY
August * 2011 =

Mo | Tu We Th | Fr |Sa |Su
1|2[3|4a|5] 6|7
8|9 [10[11[12[13[14
1516|1718 19|20 |21
22 (2324 (2526 |27 [28|
29 [30]31]

& Internet | Protec ¥5 ~ H100% ~

2. When None link button is required.
DatePickerl.NoneRequired = true;

T 5
& alphalTworld Calendar...l. = i:hJ

|§. http://localhost:49172/Web5itel / .".'EI:| 2] |

TODAY NOMNE
August * 2011 =

Mo | Tu We Th | Fr |Sa |Su
1|2[3|4a|5] 6|7
8|9 [10[11[12[13[14
1516|1718 19|20 |21
22 (2324 (2526 |27 [28|
29 [30]31]

& Internet | Protec ¥ ~ H100% -

11. public string StartYear { get; set; }
» Description: Specifies the starting year for the calender, default value is current year - 100
« Default Value=Current Year - 100 in four digits like if current year is 2008 then it is “1908”
« Example
o Source Code
DatePickerl.StartYear = "1908";
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12.

13.

& alphalTworld Calendar... | = &J

|:¢i http://localhost: 49172/ WebSitel / .".'E|:| =) |

JODAY NOMNE

August - 19038 (=
Mo|Tu We|Th| [FEEER «
1503
1910
1911

1512
1718|1920 |}1g73

2412526 |27 [11914
31 1915
1916
1917
@ Internet | Protec| 1515 F100% -
b 1519
1520

3|4|5|6
10111213

n

1921
1922
1923
1924
1925
1926
1927
1928
1929
1930
1931
1932
1933
1934
1935
1936
1937 ~

public Unit TextboxOrLabelWidth { get; set; }
« Description: Gets or sets the Textbox or Label width corresponding to the DisplayMode
»  Default Value=100px
« Example
o Source Code
DatePickerl.TextboxOrLabelWidth = new Unit(15@, UnitType.Pixel);
Response.Write(DatePicker1.TextboxOrLabelWidth);

@ http://localhost49.,., (1| (= S
e & http:/focath... - | &

i Favorites | @& http://localhost4917

150px

30/08/2011

& Internet | Pn 5 » H100% -

=

public Style TextboxStyle { get; set; }
« Description: Apply Textbox control style
« Special Note: this is InnerProperty & we can apply Theme on it too.
» Default Value= NA
« Example
o Source Code
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<alphalTworld:DatePicker ID="DatePickerl" runat="server"
DisplayMode="TextBox">
<TextboxStyle BackColor="Maroon" ForeColor="WhiteSmoke" />
</alphalTworld:DatePicker>

@ httpy/flocalhost49... i = e
g\ 2l n\:/'- 2 | hip:--localh... v| §|

¢ Favorites | @ hitp://localhost4917]

€ Internet | Pri 45 v | H100% |v
b 1 Chanm

14. public bool TodayRequired { get; set; }
- Description: Returns boolean about visibility of 'Today' button on the calender
» Default Value=True
« Example
o Source Code
= When Today link button is not required.
DatePickerl.TodayRequired = false;

& alphalTworld Calendar...l. = ot S|

| €] http://localhost49172/Websitel /Wet | & |

NONE
August * 2011 -
Mo|Tu We[Th|Fr[Sa Su
|2

8|9 [10]11]12]13]14]
151617181920
222324252627 |28
29 |30|31 |

€ Internet | Protec #5 v H100% =~

= When Today link button is required.
DatePickerl.TodayRequired = true;
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& alphalTwarld Calendar...l = S

| €] http://localhost49172/WebsSitel /Wet | 3 |

TODAY NONE
August + 2011 -

Mo | Tu We|Th|Fr [Sa [Su

112]3]14|5/617]
8|9 [10[11[12[13[14
1516 (17 (18 (192021
2223 [24(25]26]27 |28
29 |30]31 | [

& Internet | Protec ¥ » #100% -~
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